
A Quick Introductory Tutorial: 
Guide to the CD-ROM

This Quick Introductory Tutorial is designed to get you started using the PEP 
Archive 1v3 (1920-1998) CD-ROM disc. Mac users please note: this help has been 
not been adapted for Mac users but should nevertheless be useful. Printing and 
other functions will be as usual on your Mac.

This online PEP-Help Manual may be run at the same time as you are using the PEP 
Archive 1v3 Folio Views to research the PEP Archives. Keep both windows open and 
while you work through the examples. It has been found to be more helpful to start 
using the PEP Archive only AFTER taking the 45 minute tutorial. 

Start by printing out this Quick Introductory Tutorial. 

In this way, you can read the tutorial from your hardcopy and at the same time, practice 
using your PEP Archive program, by switching back and forth between the two 
programs by pressing the ALT and TAB keys together. 

Note:      Please make sure that you have only this PEP-Help and PEP Archive Program running, or 
else using Alt Tab will take you to other opened programs as well.

To Print This Tutorial: Click on the Print button at the top Menu Bar or press the short 
cut key 'P' and it will print out using your default printer and settings.

For More Information on...

Printing If and when you want to print the rest of 
the PEP-Help Manual,

Click here for more information or find 
and print out the topic "How to Print out 
this PEP-Help Manual" in the Contents 

The PEP-Help Manual 
(PEP CD Archive Help)

PEP-Help is an ordinary Windows Help 
file in which you can scroll up and down 
each topic or you can go to the Menu Bar at 
the top of the window and use the Contents
button and the Index button, Back button, 
and << and >> button to navigate around. 



*Click here for more information or find 
and printout the topic "How to use this 
PEP-Help Manual" in the Contents.

Folio Views 4 *Click here for more information about 
Folio Views, the premiere information data 
base and search engine-- or find and print 
out the topic "What is Folio Views"

Likely things that can go 
wrong at this point

*Click here for information about some of 
the common problems that may be 
encountered with this tutorial or with the 
disc 

1. Getting Started

To begin the tutorial you need first to make sure the CD is in your CD drive, if you have 
not done a "Full Install". 

IMPORTANT NOTE: YOU MUST MAKE SURE YOU HAVE THE INFOBASE 
CD IN THE DRIVE, NOT THE SETUP CD, OR YOU WILL CRASH YOUR 
SYSTEM!

Then start Folio Views. To learn how to start Folio Views:

*Click here if you have Windows or print out the topic "Starting PEP CD-ROM in 
Windows" 

*Click here if you are running a Macintosh version of the disc or print out the topic 
"Starting the PEP CD-ROM on the Macintosh"

     Start the PEP CD Archive (Folio Views). Switch to Folio Views now if its already running.

*Click here for more information about how to switch between PEP-Help and Folio 
Views or find and print out the topic in PEP-Help: "How to switch between PEP-Help and 
Folio Views"

The Folio Views opening window should look like this, except without the yellow 
callouts which label the different tools and views:



     

Each of these tools will be explained as we go through the tutorial. But first, we want to 
get you familiar with the Search Engine. 

2. Find What's Been Written on a Topic 

PEP has customized the way the Folio search engine works to make it a particularly 
powerful tool to search the psychoanalytic literature. 

Search engines have a complex underlying logic. Those who are really interested and skilled can use Folio 
Views to develop their own special searches. But PEP has tried to make it easier by creating THREE
customized methods easily accessible by buttons to be found in the top left hand side of your screen, on the 
Toolbar. You will see three search icons labeled 1, 2, and 3 and an icon that clears the searches. 



     Finding One Term

You will find that using the specialized PEP Search by Context dialog will make most 
all your searches very easy. There are several ways to get to the Search by Context 

dialog. But by far the simplest way is just to press the Search by Context icon found 
on the Toolbar on the top of your screen and shown here:

The box in the middle of the Toolbar is called the Query Dialog box where you can type 
in terms to do a ranked search. There are different navigational arrows for browsing and 
Study Aids tools on the left side.

Another way to access the Search by Context -- "Author, Title, Journal Year, etc." Menu 
is to

 Select 1. Search by Context from the pull-down on the Search Menu Bar at the top of the Folio Views 
screen or keystroke Control + 1 [Ctrl +1]. 

This is what the Search Menu looks like:

     

After you click on the icon or select the Search by Context pull-down menu, the PEP Search by 
Context screen appears.



     Start by positioning your cursor in the first dialog box . 

     Type in: countertransference and your screen will now look something like this.



Notice that the “radio” labeled “paragraph” on the top right of the Search screen is checked – this happens 
by default. This means that we have looked for all the paragraphs in all the articles on the disc where the 
term “countertransference” appears. You can see in the "Results Pane"that the search for 
countertransference yielded 4348 articles where a paragraph with this term can be found. 

The “word index” appears in the left window of the Search screen and shows the varieties 
of spellings, partly due to copy editing errors in the original journals, partly due to the 
different parts of speech). 

You may feel these are rather a lot of articles to look at! However, the point of a search of this kind (and 
the great advantage of the PEP disc) is that it begins to teach you how to look more precisely at what you 
might be interested in. By adding words (and concepts), you can further refine your search. 

Let us suppose we are interested not just in the term “countertransference” but in the specific question of 
the way countertransference can lead the analyst to enact with the patient. We can now refine our search by 
defining the context in which the term appears.

     Refining a Search



     Type in the word "enactment" after the word “countertransference”. 

Be sure your cursor is in the top dialog box, as before. Your screen will look like this:

In the "Results Tree" or "Results Map", you can see the previous 4348 articles where “countertransference” 
can be found and also the 1470 articles where the term “enactment” is present. The bracket joining these 
terms indicates that there are 326 articles where the two terms come together in the same paragraph. 

Limit Search to Checked Branches - For more information Click Here.

List Bibliography from your Search allows you to print your results, export them to a 
wordprocessor document, or send them to a colleague. For more information Click Here.

     Place your cursor on the second of the two radios marked “article” and click.



There are 772 articles or hits, a finding that illustrates the different function played by the 
paragraph and article radios. When the article button is checked it means we have found 
an article where the two terms appear somewhere. When the paragraph button is checked 
it means the two terms were in the same paragraph

IMPORTANT: The paragraph context makes it much more likely the articles found 
will contain discussion of our topic – countertransference enactment.

The point just made can be verified by actually looking at the articles we just found. But
first we need to establish how to display your results and navigate through them.

     Displaying Your Results

After pressing OK to run the previous search on countertransference enactment, your 
document window will show the first place in a paragraph by Aarons, where the words 
countertransferene or enactment are. To go to the top of the article, shown below from 
your search countertransference enactment, 

     Press the navigational button to go to the top of the Aarons article. 



The Tabs bar shown at the bottom of the screen above, allows you to select different 
views of the data, i.e. different options for displaying the window panes of information, 
depending on what you find convenient and what you want to do. 

You can have All the panes, just the Document pane (for document reading), or the 
Ranking pane (which lists the hit references in ranked order. You can select the
Bibliography window pane (gives full bibliographic information for each article and lists 
the hit references in alphabetical order by author), or you can select the Search view , 
which gives you the Document and Ranking window panes. The Browse view pane gives 
you the Document and the Bibliography window panes. The Graphic tab is used to look 
at tables or pictures in an article. When you double click on a graphic, it automatically 
zooms to an enlarged view in the Graphic screen. 



You can change the tabs to have a different view. Experiment with each view yourself by 
clicking on the relevant tab. 

     Browsing through your Search Results

There are various ways of browsing quickly through your search results to see what you 
have found. To learn about each of the different navigational buttons and their functions 
click here. 

NOTE:           Before you move to the next or previous hits or articles, you MUST make sure that 
your cursor is in the Document Window pane by moving the cursor onto text in the 
document and clicking the mouse button.

     Printing your Search Using List Bibliography

You can also print your results or export them to a word processor or send them to a 
colleague. 

   Type in your words to search in any of the custom search screens or and check the box "List 
Bibliography from your Search".

  Click OK

The complete bibliography that you just searched appears in the document window.(For 
more detailed discussion go to "Using List Bibliography" and click here. The list 
appearing in the document window can be cut and pasted into your word processing 
program and printed. Click here to learn how to email your search to a colleague.

3. Making Sense of your Search Results

Let's return to the last Search by Context search we did on countertransference and 
enactment. 

   Open the Search by Context Screen using the icon or [Ctrl + 1]. 

Look for the previous search by clicking on the Previous on the bottom left hand side of your Search 
screen. Click it as many times as you need until the last result comes back – the one showing 772 hits. 

   Click OK



Aarons 1975 article displays with the one of the terms “countertransference” highlighted. 

Note: In this article search the two terms did not have to appear in the same paragraph., 
they only had to be anywhere in the same article. 

   Re-Open the Search by Context Screen using the icon or hit [Ctrl +1]. 

 Click Previous 

 Check the paragraph level radio 

 Click OK



 Click on the to move through the hits in the paragraph and notice that countertransference and 
enactment are both together in the same paragraph creating a more limited and specific search. 

It is curious that Paula Heimann’s 1950 article on countertransference, often considered 
one of the most important influences on modern psychoanalytic technique, does not 
appear in the list of articles in the Contents window. In asking why not, we will come to 
understand much more both about the PEP CD and how Folio Views works as a search 
program 

Remember that the search we just ran will only pick up the articles which use the term 
countertransference. Perhaps Heimann’s work does not appear because she writes about 
the analyst’s feelings, rather than the term countertransference. To search for articles 
which contain the phrase "analyst's feelings" requires a phrase search.

Click on the Search by Context icon or [Ctrl +1].

     Type in the top window the phrase "analyst's feelings". 

NOTE:      You must type in the quotation marks as they identify this as phrase search. 
Otherwise, the search is for any article with the two words "analyst's" and "feelings"

     Press OK or the Return key



The results in the "Results Tree" will show 125 instances or hits shown will look 
something like this:

   

Move the cursor to the Bibliography pane and scroll down (using arrow keys) to look for 
Heimann's name. There it is!

It may have occurred to you that the results we have been getting may have been been 
influenced by the fact that for many years it was customary to spell countertransference 
with a hyphen. Like any computer program Folio Views will look only for what you tell 
it. In fact, it is designed to treat hyphens as spaces. Therefore to search for counter-
transference, you need to conduct a phrase search using quotation marks to define the 
phrase "counter-transference".

 Open Search by Context icon or use keys [Ctrl +1].

     Type in: "counter-transference" (with quotes).

There are 600 references this time. 

     Press OK or the Return Key



Notice the results in the bibliography pane, where several Heimann articles are displayed.

     Click the Tab and scroll down until at last we find Heimann.

     Double-Click on Heimann's name

   

The article will be displayed in the Document Window. We can see that Heimann uses the 
term counter-transference, not countertransference.

 Open Search by Context icon or use keys [Ctrl +1], once again.

     Type into the first dialog box c*rtr*ce

You are requesting a "wildcard search". The "Word Index" in the left pane will show the many different 
ways of spelling countertransference that are present in the database – 4351 hits in all.



4351 articles have been found with a paragraph in which at least one of these spellings present. You may 
wish to use wild cards in this way if you anticipate the term may have spelling problems or be used in 
different grammatical forms – for instance enact* will find enact, enacted, enacting, enactment, etc.

NOTE: The numbers may vary on the screens, if the screen captures were done on earlier versions 
of this final PEP Archive. See the PEP website (www.p-e-p.org) for more information about data 
entry and authoring error rates on the CD-ROM 

4. Finding Footnotes and Other Works by an Author

We can use a special feature of the disc - hyperlinks - to look at Heimann's article and use it to introduce 
some other interesting features. 

This time find Heimann’s article the quick way by again.

 Open Search by Context icon or use keys [Ctrl +1].

     Type Paula Heimann

20 articles will be shown. You could see all twenty by clicking OK. But instead just enter 1950 in the Year 
box.



Now one article is displayed. Click OK. Your document window on your screen will display the title of the 
paper and author etc. and will look like this.

The number 1 in red super-scripted at the end of the title indicates there is a footnote. Have a look!

     Place the cursor on the colored number 1 and Click - a footnote box will open to display the footnote.



     Click the X in upper right corner of screen to close this footnote box.

     Now place the cursor on the name PAULA HEIMANN and notice how it changes into a hand

     Click

Another box will open, listing all other articles in the archive written by Heimann P.

The articles listed are in color, indicating a hypertext link directly to any of them. If you 
click the cursor on the colored text you will be taken directly to that specific article. 

     Press the "X" at top right of screen to close this references screen.

     Now go back to the Paula Heimann paper "On counter-transference". 

   Click the Author information icon following the author's name.



Another box will open with information about the author, including address at time of publication.

     Press the "X" at top right of screen to close this references screen.

NOTE      If you have moved to other articles in the database, you may navigate your 

way back by clicking either on the left or right Navigation Buttons, on the Tool 
Bar on the top of your screen, until you are back in the Heimann paper. The left button 
F6 moves you back and the right button Shift F6 goes forward. 

We have seen there are twenty papers by Paula Heimann on the disc. But what about who quotes them and 
for what purpose. 

     To see all the References to Heimann in the PEP CD-ROM 

 Open Search by Context icon or use keys [Ctrl +1].

     Type in Heimann in the top Dialog Box.

Notice there are 530 articles where Heimann is mentioned in the "Word Tree"pane. 

NOTE:      **Normal paragraph level searches have been set up in such a way as to exclude 
bibliographies. This means the results reflect discussion of an author in the text, not the references at 
the end. If you are looking for a match in a bibliography click the References radio.

     Click OK

Now you can move through the actual references in the articles. Press the Next Hit (F4) or Previous Hit 

(Shift F4) Icons on the Toolbar (on the top of screen) to move from one hit to the next. You see how 
people quoted her.

5. Who cites whom?

Interestingly, close inspection of these articles by Heimann yields no apparent reference 
to the work of Heinrich Racker, an analyst widely known for work in the area of 
countertransference at the same time. In the full texts of the journals on this CD did either 
cite the other's work? This query and similar ones can be tested easily.

     Select the Search by Context icon 



     Enter Heimann into the Author field

     Enter Heinrich Racker into the Top field 

     Click OK

We can see that Heimann does not cite Racker. 

NOTE:      Entering an author's full name in the author field ensures the search will pick 
up only that author and not another in case there may be another Racker in the database. 

Now we can see if Racker cites Heimann. 

     Select the Search by Context icon 

     Enter Heinrich Racker into the Author field



     Enter Heimann into the Top field 

We can see that Racker cites Heimann three times. 

     Click OK



Looking at the Bibliography window pane Racker quotes Heimann in three papers and is 
clearly well aware of and interested in her work. 

     Open up the second of the Racker articles (Racker 1957) by clicking on it in the Bibliography 
window.

     Move cursor into the Document window pane, click the mouse and press F4 or scroll down the 
article until you find Heimann highlighted.

NOTE:      If you press F5 or use the scroll arrows while in the Bibliography window 
pane, the text in the document will remain static. You must click in the Document 
window to scroll text or display the next hit.

6. Who else Wrote that Year? 

Heimann was writing in 1950. What else was going on at this time?

     To see what other articles appeared in the volume of the Journal in which Heimann 
was writing 

     Go back to the 1950 Heimann article. 

You can do this by using the Go Back F6 icon to return you to previous screen and more specifically 
to the Heimann paper. 

Once there, you can simply click on the volume number 31, written in red on the Heiman paper 
just above the title. You will get a bibliographic list of all the papers in the volume. 
Alternatively, if you wanted to instead see the artilces place in the Table of Journals, you 
could instead:

     Click in the Bibliography window pane on Heimann's 1950 article. 

The paper displays with its title at the top of the screen. 



NOTE:      As you move the cursor over the title once again it will change from being an 
arrow into a hand

     Move the cursor over the title of the paper "ON COUNTER-TRANSFERENCE" in the document 
window and click

You will find the contents pages displayed for the year of Journal in which Paula Heimann’s article 
appeared in the International Journal of Psychoanalysis.

You can now see the articles in the volume of the Journal in which Heimann's article 
appeared. 

     Scroll down the Document Pane (using the control tab the right hand side) until you come to the 
paper On the Termination of Analysis by Annie Reich.



     Click on the red title by Annie Reich and you will see

Scroll down until you come to the following text making an interesting point of 
comparison in relation to countertransference. 



NOTE:      If you scroll down through the Document Pane a little more you see the 
original page number 183, which you might find useful for citation purposes.)

     To See What else was being Published in all Eight Journals in 1950

     Press the Search by context icon or press the [Ctrl+1] keys.

     Enter 1950 in the field labeled "Year"

351 articles - the total number published that year in this database - will be displayed . 

     Click on OK

The papers can be browsed by clicking on the table in the Bibliography window or by 

using the F4 and F5 keys. 

7. Seeing What was Said about Books or the Meaning of Dreams

There are many things that can be done using searches from the Search by Context icon 

. For example, the context can be specified to examine only book reviews or 
situations where the content of dreams have been reported.

To look at what has been said about a book in book reviews, for example, we can use the 
"article type" field and to restrict the search to book reviews.

     Press the Search by Context icon . 



     Enter "rev" in the field labeled "article type".

     Enter "The Skin Ego" in the Article Title field. 

     Press the OK button. 



There are two reviews of this book by the French analyst Didier Anzieu. Try putting in the titles of other 
books and seeing what was said.

To look at what has been said about the content of dreams, for example, we can use the "dreams" field and 
to restrict the search to those areas of the text on the disc which have been tagged as reporting dreams. (All 
results should be treated with caution as this tagging is not highly reliable). 

Let us look for dreams about “falling”.

     Press the Search by context icon or press the [Ctrl+1] keys 

     Click the “Dream” radio 

     Enter into the top dialog field “Falling” 



There are 37 dreams reported where the idea of falling occurred. 

     Enter the OK button to see in which articles they appear. 

The first hit or dream reference is in a paper by Jorge Ahumada (1995). Use F4 to look at the other 
dream examples. 

8. More Refined Searching by Context 

If we go back to our search on countertransference and enactment it will be recalled there were 326 articles 
where these two terms appeared in the same paragraph. 

     Click Search by Context icon .

While in the Search by Context Screen

     Click the Previous button on the lower left side of the Search by Context screen until you find your 
previous search for these terms countertransference and enactment at the paragraph level. 



Note: If you can not find your previous search on countertransference and enactment, 
simply type the terms into the Search by Context screen at the paragraph level and 
continue with this tutorial. 

To refine the search to a smaller number of key articles, let us think about a cluster of terms (and thus 
concepts): countertransference, enactment, analyst’s feelings, interpretation, living out the (transference) 
and let us make use of the logical operators “AND” and “OR”. Let us also use the wild card method to 
search for variations of words such as interpret, interpretation, interpreting etc. In order to capture this 
expression of these concepts: 

     Remove the previous terms countertransference and enactment.

     Type in the top dialog box the following: c*tr*ce or "analyst's feelings" and enact* or "liv* out" and 
"interp* of"

Note: You can actually cut and paste these words and then drop them into the top Dialog box. 

You can see firsthand the "Word Tree" work as it carries out your search. Be patient as 
this complicated search may take up to a minute or more to do. You will see that you 
have narrowed your search to return 50 key articles with these concepts. 



In these 50 articles and in the same paragraph we find mention of either countertransference (in various 
spellings) or the analysts’ feelings together with the concepts of either enactment or living out and of 
efforts to interpret it.

     Click OK and the results display in the bibliography pane and can be inspected. 

     Press F4 to advance to the first paragraph where the terms can be seen.

Your screen should look something like this:

This screen shows the first paragraph with hits. It is an article by Bawdry (1991) and is clearly precisely 
discussing the topic we are trying to learn about.

     Continue to press F4 to advance and scroll through for other paragraphs with hits in the other 
articles. 



Many of the 50 articles are relevant, showing how relevant results are achieved by defining the search 
context carefully. You will find, for example, Schafer’s (1991) review of Betty Joseph’s work. 

This book review can be found many ways. But the simplest method is to use your current search. 

     Put your cursor in the right bibliography pane. Scroll down and click when you get to Schafer 
(1991)

Any number of such searches can be attempted but a word of warning – the search tools can only find (a) 
text in the articles in the Journals in the database and (b) is only as reliable as the search you construct. 
Thus although the search we just constructed and used did find a review of Betty Joseph’s work on the 
topic – and her work is one of the most illuminating contributions on this topic – it did not actually find her 
articles – Betty Joseph is not in the bibliography pane on the search we just did. 

One of her key articles on the topic is there, however. So to find Betty Joseph's work:

     Click on the Search by Context icon .

     Type Betty Joseph in the Author dialog field



We can see she has 14 articles.

     Click OK

Her articles can be displayed in the bibliography pane.

Looking down the articles put your cursor on Joseph’s 1985 article and scroll down to page 448.

Here you see that Joseph is discussing exactly the topic of our search and uses phrases like (the analyst) “is 
living out the patient's own defensive system” and the term “countertransference” but not quite in the way 
the search requested. 



The lesson is to search widely and to try to think of different ways authors might construct their thinking on 

your topic. PEP’s Search by Context is a very powerful tool but like all tools requires thoughtful 
direction and application. 

9. Ranked Searching

PEP’s Search by Context icon is now clearly the search method of choice, because it allows 
intelligent specification based on meaning and does not rely on strictly crude quantification of a term 
occurrence as does the ranked search.

It is possible, however, to do a simple counting search that may be useful as part of finding out roughly 

what is written on a topic and how to set up many effective Search by Context searches.

The ranked search can be of help here. A ranked search or ranked "relevancy" searches uses the Query 
Tool, shown below with the terms c*tr*ce or “counter-transference”. The Query Tool (or dialog box) is 
defaulted by Folio Views to always show only the top 50 articles as ranked by relevance - that is articles 
containing the most occurrences (hits) of the searched term. The results are displayed in ranked order; the 
article with the most matches (hits) appearing first. 

The simplest way to do a ranked search is to type a term or terms into the Query Tool as shown here.



     Type in c*tr*ce “counter-transference”

     Press Enter

The 50 articles which use the term countertransference most (in its various spellings) 
have been “found” and are displayed in the Bibliography pane and in the ranking pane. 
The ranking pane places the “hits” in order – the article with the most density, with the 
most mentions of the searched term appears first. In this case it is an article by Douglas 
Orr (1954).

Ranked searching is limited in value because, for technical reasons, it works only at the article level – in 
other words it will search for the presence of numbers of terms but not in the same paragraph, only in a 
whole article. It is a blunt instrument with none of the subtlety of being able to Search by Context using 

the icon.



Using New PEP Customized Advanced Query and Rank Search 

As you can see you are limited in doing the ranked search as certain special Views search 
tools do not operate there and you are only searching at the article, not paragraph level. If 
you wanted to limit your search or make it more conceptually specific, you could use the 

Advanced Search using the icon.

Note: Whenever conducting a ranked search and some other specialized searches 
from the Advanced Search mode, you will not be able to List your Bibliography. 
However, this dialog allows you to more easily insert the rank number you desire.

There are three ways to get the Advanced Search dialog. 

 Press the Advanced Search icon or 

   Keystroke [Ctrl + 2 ] or

   Select Advanced Search from the Search Menu pull-down at the top of your screen. 

Now let's say you are interested in knowing about countertransference, enactment and acting out. 

 Type c*rtr*ce or "counter-transference" enactment

You will get the following screen:



Notice the "Word Tree" work as it searches the infobase for your words in each 
paragraph of each article, yeilding 333 articles where these words occurred in the same 
paragraph. If you instead clicked the Article radio, your results would expand to 786 
articles, where these terms appeared anywhere in the article.

This search needs to be limited. An easy way to quantitatively limit the Advanced Search 
by using the Rank field to type in a number and select the Rank radio. So, using the 
Advanced Search shown above for c*rtr*ce or "counter-transference" enactment:

 Type 75 into the Rank field and select the Rank radio. 

If you typed in 75, you would get the top 75 articles that had AT THE PARAGRAPH 
LEVEL, the terms you were looking for. As you know now, the the closer in proximity 
the terms are to each other, the more likely they will have increased meaning. 

Note: The Ranked Search Query Tool does also default to 50. However it searches at the 
article level, not the paragraph level. Further, many advanced searching operators can not 
be used in the Ranked Search Box. 

 Click OK to close the Advanced Search Box and display the results



 Select the Ranking Tab (on the Views Tabs Toolbar) to see the 75 articles displayed in order of the 
number of hits. It will look like this:

If you look at the results of the ranked articles in the top 75, it is interesting to observe that most of these 
papers are published in the mid to late 90's. 

Note: The Bibliography window (seen on the right side in the All view) displays the 
same articles in alphabetical order).

 Continue to press F4 to browse forward through each hit. Press F5 to advance forward though 
each article. 

*Click here to learn more about the many searching methods. 

IMPORTANT NOTE: PEP has designed these custom search tools for your convenience. 99% of 
your searches can be done using Search by Context. The Advanced Search allows you to List your 
Bibliography from many advanced searches and to effortlessly do a ranked search. For even more 
power is available using the Folio Views query syntax by referring to Folio Views Help on Advanced 
Query [F2].

 Using the Search 3 icon or [Ctrl +3]



Let's say you were reading a paper in your hardcopy journal and wanted to use the 
reference for some of your research or teaching. Here is a quick way for you to go 
directly to the specific text on the PEP Archive:

   Select Search 3 icon or [Ctrl +3]

or go to "Search" on the Menu Toolbar 

     Select "Go to Specific Volume(s) or Page(s). 

You will see the following screen where we have looked for a reference from 
Psychoanalytic Quarterly in Volume 66 and on Page 726. 

     Press OK and you will go directly to the top of the article where the page reference is located. 

     Continue to press F4 a few times and you will get to the page number.

Click on the icon to Cancel Search.

This PEP customized Cancel Search icon is located on the Toolbar on the top of 
your PEP Archive screen. By clicking on it, you will cancel and thus clear your search.



10. Study Aids: Making your own Notes and Annotations

The Folio Views program has a very useful feature that permits you to use various
STUDY AIDS to mark passages you want to return to, to write your own notes on 
passages and to create your own index of articles on topics that interest you. It is as if you 
had the paper journals on your desk but with the added advantage of being able to search 
your study notes and indexes just like as you can with the database. 

*Click here for information about how to use Study Aids. Or access the PEP-Help 
Contents or Index Menu and select and print out the section " Study Aids - Bookmarks, 
Highlights and Notes". You may want to do this later as there is still a lot to absorb

  

11. Printing out a Complete Article or Selected Text 

The PEP CD-ROM allows you to print out complete papers, selected text, the ranked hit 
list and the bibliography contents. These features are strictly for your personal use and 
subject to the copyrights set out in your license agreement found on your Start--
>Program-->PEP Archive 1v3 menu. 

     Printing a complete Paper

Using any of the methods described above, select the paper you wish to print out. Once 
the article is being displayed in the Document pane, you may print it out by selecting the 
Print icon found at the top left hand side of the screen or you can use the File Menu and 
select menu item Print.

Note: Your cursor must be in the document window in order to select what is there 
to print. 

     Click on the Print icon 

The following Print dialog box will be displayed.



The article selected can be found listed with other titles in the section field as seen in the 
example of the Print dialog Box above. If you wanted to print the article by Abend, S. 
(1993) An Inquiry into the Fate of the Transference in Psychoanalysis, you would need to 
locate the article in the list of articles. Then, make a checkmark in the box next to this 
paper. Automatically, the dot in the radial will move from Record to Section. You are 
now ready to print. Make sure the Section radio is selected. 

     Click on OK 

The complete paper will now be printed out (Macintosh users: click continue, then click Print).

NOTE:      A glitch in the program--

Problem:      After printing, the program will NOT automatically uncheck the article.

Solution:      After printing, you must manually UNCHECK the box or the next time you 
try to print an article, you will also print whatever articles you still have checked. You 



can uncheck going to the Edit Menu option "Clear All Checks. Another method is to 
right click anywhere in the bibliography pane and select "Clear all checks". With either 
method your cursor must be in the bibliography pane.

IMPORTANT: Never click the "all" radio in the print document screen as it will 
cause your computer to print out the entire disc, but because of memory and disk 
space limitations, it will likely cause your computer to require a "restart".

NOTE:      The paper size and widths of margins can be changed by selecting Page Setup 
from the File Menu. The Font and the Font size for printing can be changed by selecting 
Options from the Settings Menu. If you select the Print Tab you will see the Font field 
and Size fields displayed. You may change the font and font size for printing here.

     Printing your own Bibliography List

On PEP's customized searches, we have designed a special program that will let you 
export and print the results of your search. First you must go to one of the PEP 

customized searches either Search By Context (use the icon) or Advanced Search 

(use the  icon) located on your Toolbar at the top of your screen. Let's run one of our 
previous tutorial searches with slight modification. 

     Click Search by Context icon .

     Type in the top dialog box the following: c*tr*ce or "analyst's feelings" and enact*

We can further limit the search so that we only see papers written in the Journal of the 
American Psychoanalytic Association putting the journal code APA in the Journal Box. 

   Check the "List Bibliography from your Search" box 

You can find this "List Biblio" at the bottom of your PEP Search Screen. You can see the 
Word Tree searching. It then tells you that there were 585 references. By further limiting 
your search to a specific journal (in this case APA), there are now 118 references.

     Click on the OK tab

All of your references are in the Document Pane ready to be searched, exported or 
printed. The printing method is the same as printing an article explained above. 

To print your "List"



Select the Print icon

Select the Print Document Tab

Select the All radio and Press OK

Your bibliography list in the document pane will print out for you. 

     Printing out selected text

To print out selected text, first select the text you wish to print out. This selection of text 
is done in the same way it is done when using your word processor. Place the cursor at 
the beginning of the text you are selecting then, while holding down the Shift key, place 
the cursor at the end of the text and release the shift key. (Alternatively, for a short bit of 
text, click the cursor at the beginning of the text then while holding down the left mouse 
button, move the cursor to the end of the text and release the button.) The selected text 
will now show as highlighted in a color.

     Select the Print icon 

You will see that the "Selection" radio has been selected automatically. 

     Click on OK The selected text will now be printed out.

     Printing the Ranked Hit List

Printing the Ranked hit list is for printing out your results from running a Ranked 
Search. As you recall this search can either be done by typing words into the Query 
Tool dialog box located in the middle of the Toolbar or by using the rank radio 
located on the Advanced Search screen accessed by using the Advanced Search icon 

or [Ctrl + 1]. 

     Select the Print icon 

When the Print Dialog Box opens,

     Select the Print Hit List Tab



     Click on the All box to print the entire Ranked list of references. Your screen should look something 
like this.

     Click on OK to print out the Ranked List of references.

NOTE:      In order to get a ranked hit list, you must perform a "ranked search" 

     Printing the Bibliography (Contents) or complete reference list

     Select the Print icon 

When the Print Dialog Box opens,

     Select the Print Contents Tab

     Click on the All box 



     Click on OK to print out the complete List of references.

12. Using the Copy and Paste Commands 

The PEP CD-ROM includes a copy command feature that allows you to highlight and 
copy text and images to the Clipboard in Microsoft Windows. This feature is provided for 
your personal use of the product. For example, you may wish to copy information on a 
certain topic to an electronic file to make a research file (notes, lecture, draft paper) for 
your future reference. You may wish to print out an article to read at a later time when 
you are away from your computer. For more instructions you can refer to the section on 
Printing, Copying and Pasting text by clicking here.

However, copyright law does not allow you, for example, to copy an article for 
commercial publication or for posting onto a computer bulletin board. These examples 
are illustrative, and are not meant to summarise applicable law. See your license 
agreement for details.

The cut, copy and paste commands are the same as those that you probably already use in 
your word-processor. 

To copy text from an article into an open document in your word-processor:

     Select the text. (See the section on Printing out selected text above)

     Press [Ctrl + C] to copy. (Alternatively select Copy from the Edit Menu)

     Minimize the Folio Views window by clicking on the Minimize Window button at the top right 
side of the Folio Views window Tile Bar 

From the Start Menu (Windows)



     Open your document in your word-processor. 

     Move your cursor to the place where you wish to place the text.

     Press [Ctrl + V] to paste the text. (Alternatively select Paste from the Edit Menu)

The selected text will now be in your document. 

To get back to Folio Views exit or minimize your word-processor and maximize Folio 
Views by selecting the Folio Views tab on the Taskbar (Windows)

13. How to Email a Colleague your Search Results

Let's say you would like to email your colleague the results of a paper you are working 
on about transference and countertransference resistance and training analysis 
terminations. 

First open up your email and type in your colleague's email address and name. Then 
switch back to your PEP Archive and run a search.

 Select either Search by Context or Advanced Search icon. 

     Type in the top dialog box the following: "training analys*" termination and resistance and search at 
the paragraph level. 

   Check the "List Bibliography from your Search" box 

By clicking on "List Bibliography"the results of your search, in this case 12 references, 
will be displayed in the Document Pane. To cut and paste the entire contents of your 
search results: 

     Select the text by putting your cursor in the upper left side of document window on the name Garma 
and click. 

 Hold the shift key down and at same time, move cursor to end of document and click.

All of the text in the Document Pane will be highlighted. 

     Press Ctrl + C to copy. (Alternatively select Copy from the Edit Menu)



     Minimize the Folio Views window by clicking on the Minimize Window button at the top right 
side of the Folio Views window Tile Bar 

     Re-open your email document by clicking on your tab tray on the bottom of your screen. 

     Move your cursor to the place where you wish to place the text.

     Press Ctrl + V to paste the text. (Alternatively select Paste from the Edit Menu)

Here is an example of one such email generated from this search. 

14. What's Next

Other sections in this PEP-Help Manual and in the Folio Views Help (available from the 
Menu bar when running the PEP disc) introduce you to other features. As it is difficult to 
take in a lot of information at once and without a task we envisage you looking at these 
two sources as you go on with your research. 

Use the instructions in the remainder of the PEP-Help Manual and in the Folio Help files 
to become more and more expert - but first *click here for some important information or 
select and print out "What to do and Not to do when first using Folio Views" from the 
Manual Contents. This gives a few warnings and bits of technical information which will 
keep your use of the disc minimally complicated.



PEP is continually working to improve the disc and make it more user-
friendly with each update.

Press B to return to previous text or Topic 
Press C for Contents 


